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Your Camera 
Dial 
Basic Modes 

What else can you say – it does what it says on the tin! Auto is quite literally the  
automatic mode that most beginners opt for. The camera will choose all settings 
based upon its light meter reading which is taken milliseconds before you take a 
picture – so quick you won’t even notice. Sometimes it may be symbolised by a simple 
green rectangle. 

This icon is your macro function, which will allow you to unlock an extra focus range 
on your camera so you can get in nice and close to capture small details, ideal for 
floral, insects and abstract photography. Remember to switch back to different 
setting after using your macro mode though, otherwise you’ll suffer a delay in your 
focusing time. 

For the landscape lovers, most cameras have a dedicated mode for bringing out the 
best in a scene. This option will automatically make the camera focus on as much of 
the scene as possible by using a wide depth of field. The camera may also use a 
slower shutter speed in some cases to compensate for the small aperture, so it’s 

always worth using a tripod to avoid camera shake. 

Sometimes called night or party mode, they both mean the same thing – its suitable 
for working in low light. Night mode forces the camera to use slower shutter speeds  
knowing there isn’t much ambient (natural) light available. It will fire your flash  
automatically to help with the exposure, so expect some quirky light trails along with 
freeze framed motion. 
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Your Camera 
Dial 
Basic Modes 

Ideal for action and rapid movement, sports mode will do the opposite to night mode 
and push the shutter speed to a higher rate to make sure any motion is frozen still, 
and no movement blur occurs. The camera will widen the aperture if necessary, to 
compensate for the fast shutter to make sure you get an even exposure. The camera 
may implement a facial tracking focus mode to make sure the focus follows the 
action, but this depends on the camera. 

One of the more common features on the camera dial is the unmistakeable portrait 
mode – suitable for humans and animals (but subjects in motion maybe better in 
sports mode). The aperture will be widened significantly to reduce the depth of field, 
throwing the background out of focus and making your subject the obvious feature. 
Use it for formal portraits rather than candid shots, which can sometimes end up soft 

if there is movement. 

The flash will not fire under any circumstances, ideal if you are trying to be discreet 
with some street photography. Not common on many camera dials nowadays as its 
normally included within the menu system under flash settings. 

This is an option for shooting specific specialised scenes (sometimes called creative 
modes), the choices will vary brand to brand, so it is hard to detail all of them. You 
may see options such as Candlelight, Autumn Colours, Dusk, Toy Camera Effect, 
Miniature Effect and High/Low Key. The camera may adapt the settings to suit the 

scene. 
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Your Camera Dial 

Advanced Modes 

The power is in your hands with manual mode, the camera will sit back and let you 
make all the decisions over aperture, shutter speed and ISO. It will not help you 
balance the exposure if you get your settings wrong, but learning this function opens 

up a whole world of fantastic creativity! 

It’s like a shared responsibility these next two options – part of the decisions will be 
made by you; the camera will help you out with the rest. Aperture priority allows you 
to choose the size of aperture, but the shutter speed and ISO are automatically 
adjusted to give you the best exposure possible. It’s great to use if you want to learn 
about aperture, but without the burden of other settings. 

So, if you understand aperture priority, then shutter priority will be a piece of cake! 
It’s a fantastic tool to use if you want to learn about the effects of long exposures its 
relationship to capturing stunning motion photography. The camera will continue to 
change the aperture and ISO based upon your chosen shutter speed. 

Despite aperture and shutter speed being extremely important to photography, they 
aren’t the only functions that need consideration on your camera and program 
mode will help you learn them. Switching into program allows you to control ISO, 
exposure metering and white balance whilst shooting. Ideal for those slightly more 
advanced users who like to perfect their work when out in the field. 

To read more about this section click here to access 250+ free photography 
articles to help you take amazing images and become a fantastic photo editor. 
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Drive Modes 
Long gone are the days where you just turned your 
camera on and shot a picture, now even that basic 
step has choices to it - how many pictures do you 
want to take in one shot and when does it start?  

 
This is all decided in your camera’s drive 
modes. 

 

Continuous / Burst 
In continuous or burst mode your camera will keep shooting shots the images for as long as you 
are holding down the shutter. You may have guessed by now that sports, transport, animals, 
and candid portraits of children are perfect subjects for this drive mode. When you are reviewing 
your images, you can cycle through all the candidates and pick the one that captures the story 
best.  
 
Be aware though that you will need a fast-writing memory card and a large capacity, especially 
if all these burst shots are in RAW formats. 
 
Depending on your camera, you may only have access to one rate of burst or frames-per-second 
(fps) speed. The higher the spec of the camera generally the choices increase.  
5-7fps bursts are common but it is not unheard of to over 20 in some bodies. In cameras where 
there are multiple burst rates you may have the choice between low and high. 
 

• Low: The camera will still take multiple shots but at a slower rate. This is good if you 
want to take several shots of a specific movement, but not ramming your memory 
card with files. 
 

• High: Ideal for dealing with high action events such as sprinting or race cards. Use 
this continuous high burst drive mode alongside a fast writing and large capacity 
memory card, otherwise you’ll be out of space quickly. 

Single Shot 
Single shot is generally the default for most and means you’ll only take one photo with each 
press of the shutter. Until you’re faced with a situation that warrants different drive mode, then 
single shot is your safest bet for 99% of your photography.  
 

Self-Timer 
A simple drive mode which gives you a little more time before the exposure starts.  
 
 
 
 
 
Either way, cameras will have options of 2, 5 or 10 second countdown timers to work with. As 
soon as your press the shutter button down the countdown begins signalled by either an audio 
beep or a quick flash of light. 

• Maybe you want to get in the shot yourself?  
• Or you’re shooting some long exposure landscapes and don’t want to touch the 

camera? 
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Drive Modes 

Mirror Lock-Up (ML-Up / MLU) 
To help reduce blur caused by camera shake, most DSLR cameras feature what is called the 
Mirror Lock-up drive mode. If it is not listed in your main drive mode menu then check other 
menus in case, it’s a little hidden. 
 
In ML-Up mode your camera will wait until the mirror has lifted to take a picture. You can 
understand why lots of landscape, macro, night photographers use this drive mode as it helps 
with long exposure or close up situations where little vibrations make all the difference to the 
sharpness. 

To operate: Some cameras will require you to press the shutter button twice: First press will lift 
the mirror, and then the second will take the shot. With that said more advanced DSLR’s have 
made the technology more intuitive to run the whole action itself meaning you only need to 
press the shutter once and the mirror locks up and then the shot is taken briefly after.  
 
Be careful with this automation though as you can’t time action shots as accurately. 

Quiet Mode 
Some cameras which have a mirror door, which flips up and down to reveal the sensor behind it 
during an exposure, will create noise when in operation. It’s a little clicking sound that most of us 
get used to when taking pictures.  
 
But there may be times you want to stay more discreet with your camera, for example in street 
photography. In this situation a quiet drive mode is perfect. It works in the same way to single 
shot drive mode, but the mirror door opens slower to avoid the clicking sound (it won’t make a 
difference to your shutter speed). 

 

To read more about this section click here to access 250+ free photography articles to help 
you take amazing images and become a fantastic photo editor. 
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Sports / Motion / Transport (Moving Subjects) 
Continuous Autofocus (or “AF-C” on a Nikon and “AI Servo” on Canons) 
 
AFC places multiple autofocus ‘points’ on your subject and continues to adjust these points while your subject moves. You need to keep the shutter button 
half-pressed and your subject frame as they move for the focus to track correctly. 
 
This is ideal for capturing movement in your shots. Athletes or just leisurely cyclists all benefit from AFC. Once you’ve spotted your subject track them by half-
pressing on the shutter button and move the camera to keep them in the frame. When you are ready to take the photo, fully press the shutter down, and 
the camera will focus on your subject for a sharp image. 
 

Focus Modes 
In a similar way that exposure meters can read light in several ways, you 
can also educate your camera on how, and where, you want to place your 
focal point. 
 

Still Life / Product / Landscapes (Stationary Subjects)  
Single Shot Autofocus (or “AF-S” on a Nikon and “One Shot” on a Canon) 
 
AFS locks focus based on the distance to your subject. As long as your subject stays at that distance, your photo will 
be sharp. In some instances, your camera may not take the photo if your subject is moving. 
 
But the benefit is that AFS allows you to recompose whilst retaining focus. Imagine that you focus on the middle of a 
frame, but your main subject looks better further to the left or right. All you need to do is keep your shutter button 
half-pressed to firstly lock focus on your subject and then (whilst still half-pressing the shutter button) shift your 
composition to suit. If you don’t change the distance between camera and subject, then your shot should still be 
sharp. 
 

When using AF (autofocus), like most of us do, your camera decides what it should use as your focal point. This is based on what looks most prominent in 
the viewfinder or closest to the camera. But if you want a little more control over where and how much your frame is considered in this focus conversation 
then you’ll need to consider the subject in the shot it’s potential for movement to choose the right method. 
 

 

It’s important to understand the focus of your image may not always be in the dead centre of your 
frame and therefore selecting a different focussing method may help to improve the story for your 
audience in your composition. If you’ve been seeing unwanted blur in your photos, then changing up 
your focus method may improve that essential sharpness. 
 



Focus Modes 

Children Portraits / Pets 
Hybrid Autofocus (or “AF-A” for Nikon users and “AI Focus” for Canon users) 
 
This method merges the functionality of the AFS and AFC. Basically, it begins as AFS but 
your camera needs to lock in focus on a stationary subject first. Only then can you take the 
photo as you would in a traditional AFS mode. 
 
But - and here’s the magic - if your subject starts moving, the AFS stops, and AFC takes 
over to track your moving subject. It gives you the best of both worlds.  
 
Be aware though, if you recompose a stationary object quickly in AFS mode, the camera 
may think the subject is moving and release the AFS too soon. Try to keep the camera still 
until you’ve got your subject in the frame. 
 

To read more about this section click here to access 250+ free photography 
articles to help you take amazing images and become a fantastic photo editor. 

 

“Why Are My Photos Blurry Sometimes?” 
 

You might be too close to your subject. Take a step 
back. If you are too near the subject, it might prevent 
the camera from focusing properly. Every lens has a 
minimum focus distance that you need to maintain 
for quick focus, look it up in your manual to know the 
requirements. 

 
 

Possibly there’s not enough contrast in the shot. Your 
image needs to have some contrast for many AF 
systems to work. Imagine trying to photograph a 
white sheet of paper in the snow. Your camera relies 
on comparing adjacent pixels to find contrast, but if 
you have too many pixels of the same colour/tone 
then it’ll be impossible to get focus. 

 
 

If your depth of field is very shallow i.e. shooting at 
F/2 or wider then despite the AF system working it 
may just be so shallow it’s impossible to see the focus 
area as it’ll be so small. Entry-level lenses with wider 
apertures F/2.8 and wider do suffer from this paradox. 
Higher quality glass will make a difference in this 
situation.  

 
 

Is your shutter speed too slow? Camera shake can 
account for areas of blur that occur during your 
exposure, even if your subject isn’t moving. Make sure 
your shutter speed is faster than the equivalent of 
your focal length (the reciprocal rule - important for 
long focal length lenses).  
 
For instance, shooting at 200mm, your shutter speed 
should be 1/200th or faster to avoid camera shake. 
Tripods will always add an extra level of stability on 
top of this. 
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Focus 
Stacking 

In the same way that exposure can be bracketed for enhanced detail, so can focus for a 
deeper level of detail throughout the depth of field. This can be really helpful when you are 
working in low light situations (landscapes pre-sunrise and post-sunset) and you’ve 
opened up your aperture but left with a shallow depth of field. 
 
Focus stacking requires several shots to be taken manually at different focal planes, 
from a nearby subject through to the furthest point in the distance. 
 

Tip: Don’t change any other camera settings for the shots to match up in editing - touch 
screen focus tools are great in this situation.  
 

How many shots you take to stack will depend on how many focusable objects are in the 
frame, 3-5 will generally be enough though. Otherwise, you could also opt for manual focus 
and judge by eye different focal planes to take shots at. 
 
To stack the effect in editing layer all shots together in the order you took them and 
erase/mask out the blurred areas on each shot to reveal a wider depth of field containing 
sharpness front to back. 
 

Layer all 3 images in editing and erase out all the blurred areas to leave your image with 
front to back focus. 

Take 3 shots… 

1 x Focus on the Foreground     1 x Focus on the Mid-ground    1 x Focus on the Background 
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Focus 
Stacking 

Align Your Layers 
In Photoshop go to File>Scripts> Load Files into Stack. Select your files and check Attempt to 
Automatically Align Layers and click OK.  
 
If the option to align isn’t available in your version, you'll need to align the layers by selecting each 
layer in the Layers palette while holding Shift key and choose Edit>Auto-Align Layers. Leave Auto 
selected and click OK.  
 
 
 
 
 
 
 
 
 
 

Automatic Stacking 
To let Photoshop’s automatic blending do the 
work, go to Edit>Auto-Blend Layers and select 
Stack Images and click OK. Turn off Content 
Aware Fill Transparent Areas.  
 
Once it’s complete you can apply any final crops, 
tonal, colour and sharpening tweaks to your 
image and save as a JPG. 
 

Manual Stacking 
You may prefer to manually blend your images. 
When you have all your images aligned in the 
Layers palette add Layer Masks to all the layers 
(Layer>Layer Mask>Hide All). Using the Brush Tool 
set to White, meticulously brush over the sharpest 
areas in the scene as you work your way back 
through the image. 

To read more about this section click here 
to access 250+ free photography articles to 
help you take amazing images and become 
a fantastic photo editor. 
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Exposure 

Metering 

Spot Metering  
In spot mode, your exposure meter will read light from a small area – around 4-5% of the frame. Place the spot 
exactly where you want to take your reading from, it’s normally in the centre of your frame, but some cameras 
may allow you to move this spot manually. Your main subject should generally be the target of the spot 
metering. 
 
Depending upon your camera it may be possible to move the spot along with your point of focus. Do a little 
research into your own camera to find out what options are available. Because of the size of the reading area, 
it’s best to use spot metering with small subjects such as macros. 
 

Centre Weighted  
Centre-weighted mode works similarly to spot metering. But whereas spot metering reads around 4% 
surrounding the target area, centre-weighted takes into consideration an extra 50-55% (depending on the 
camera). Some camera models allow you to vary the area it covers. 
 
Portraits and still life shots are fairly good situations to use centre weighted readings if there isn’t too much 
space surrounding your subjects.  
 

Averaged  
As well as being called averaged you’ll find that camera brands have their own terminology: 
 
Nikon - Matrix metering 
Canon - Evaluative metering 
Pentax & Sony - Multi-Segment Metering 

 
Either they all work in a similar way, but each manufacturer has different algorithms to determine the 
outcome. Basically, with averaged readings the camera partitions the frame into zones and measures the 
light in each. It compares these light readings. Then averages them all out to provide, what it thinks is, the best 
exposure. 
 
It’s the go-to mode for most landscape photographers as it is useful for reading shifting light falling over a very 
wide area. Under dull weather conditions averaged readings tend to work out great but when working with 
harsh, direct sunlight it may be best to bracket your exposure shot too. 
 

 

Most digital cameras have built-in exposure meters. These meters read the amount of light in a scene to provide 
you with an even exposure. But there are several options for you to decide how that meter reads the light, and 
more specifically from where in the scene.  
 
This can be incredibly helpful as you can be more creative, stylised, and personal with the final image. Different 
camera brands refer to these exposure meter readings with varying names, but here are the most common (and 
a reflection on how they work). 
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Exposure 

Metering 

How to Read the Exposure Meter 
 
Every time you half-press the shutter button your light meter will spring into action reading the scene in 
front. The current exposure will be displayed on a little chart on your live view or through your viewfinder. 
 
Only semi-auto and fully manual modes will allow you to change it. You may not even see it when 
shooting in auto.  
 
It’s a chart graded from -3 to +3. The aim is to get the pointer to 0 - which means your exposure is as 
balanced as possible. When it drops into the negatives it means the exposure will be underexposed, and 
inversely when it hits a + it could look a little too bright. Use your aperture or shutter speed to move it to 0 
in these cases. 
 

Top Tips to Remember: 
 

• Under bright light, take a reading from the most important area of your composition. Choosing 
averaged or centre-weighted metering can result in sub-par exposure. 
 

• Spot metering is the best option when your scene includes a lot of contrast. 
 

• If you don’t use the AEL (auto exposure lock) button, then your camera will readjust the settings every 
time you take a shot. If you want to re-compose the frame slightly then hold down the AEL button to 
retain the exposure reading. 

 
• In manual mode, the exposure settings remain constant until you change them. 

 

 

-3 

0 

+3 
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Histograms 

What is a Histogram? 
A histogram is a graph representing the pixels that are visible in your 
image.  The left side shows the blacks or shadow areas, and the right side is 
about the highlights or bright areas. The middle section is for your mid-tones 
(grey areas). 
 
The height of the peaks in a histogram details the number of pixels in that 
tone. Each tone placed on a scale of 0-255 (with black being 0 and 255 being 
white) is one pixel wide on the graph. Basically, think of the histogram as a 
bar graph all squished together with no spaces between each. 
 

Most DSLR or Mirrorless cameras will have the ability to display a histogram after you’ve taken a shot - 
and sometimes during it.  
 
On top of all the other features and teachings that new photographers must learn to master their camera, 
the histogram is an easy and quick tool to understand. It will help you control your exposures and detail 
levels with much more precision. No more whited-out skies or super dark shadows.  
 

What is Clipping? 
When the graph demonstrates that there are pixels touching the extreme 
edges, this will indicate loss of detail, also called ‘clipping’.  
 
Clipping in the highlights (areas that are completely white) happens if the 
graph is touching the far-right side. Shadow clipping (areas that are true 
black) occurs if pixels are touching the extreme left. Either case this means, 
even if you raise or lower your exposure in editing to fix this, there will be no 
detail in the pixel to bring out. You’re stuck.  
 
Fixing the exposure, whilst you are shooting, is always the best approach. 
If your camera has histogram in live view mode, then use it to judge your 
exposure. If highlights are clipping for example, then you’ll know to close 
your aperture, increase your shutter speed or lower your ISO. 
 
Some instances of shooting into the sun can cause highlights to be blown 
out (clipped) so expect that it will happen but aim to minimise its impact as 
much as possible. 
 

 

Underexposed 

Overexposed 

Balanced 



Histograms 

RGB Histograms 
As well as tonal histograms you will also come across graphs that show results in red, green and blue - known as RGB histograms. Lightroom has RGB 
histograms available when editing your photos. It’s not just 3 colours being demonstrated though, there are several charts marking different colours.  
 
The grey part shows where all three RGB channels overlap. Yellow, cyan and magenta appear where only two of the channels overlap. 
 
Whilst they may look advanced and another level of complication, they aren’t. It’s best to use these RGB histograms to control which colours stand out 
the most in your image. High peaks in the graph of any colours suggest the image has a high proportion of pixels in that hue.  
 

To read more about this section click here to access 
250+ free photography articles to help you take 
amazing images and become a fantastic photo 

editor. 

 

What does a ‘good’ histogram 
look like? 
 
The type of histogram you would want 
to create, where possible, would show 
the bulk of pixels in the middle of the 
graph, and only a few towards the 
edges.  
 
A nice even arc from left to right will 
leave you with detail in the darkest and 
brightest areas which you can then 
manipulate further in editing if you 
need. 
 

Find out what else you can learn on an 

 iPhotography Course 

Click here 
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Exposure 

Compensation 

Common moments to use exposure compensation: 
• To achieve better exposure when all other settings have been considered 
• To achieve or avoid silhouette lighting 
• For creative effects like over-exposing highlights for high key lighting 
• Similarly, for decreasing bright highlights and making images appear lower key or 

low contrast. 
 

+ 3  
+ 2 
+ 1 
 
  0 
 
- 1 
- 2 
- 3 
 

To brighten 
highlights 

 

What Does It Do? 
Your camera’s exposure compensation dial will allow you to make more specific 
tweaks to your shot. If you’ve maxed out your aperture, shutter speed and/or ISO 
settings then turn to your exposure compensation option to increase or decrease 
exposure a little further. 
 
Depending upon your camera and its functionality, you should be able to use 
exposure compensation in most shooting modes (auto, shutter/aperture priority and 
manual). Some cameras disable the function when using scene modes or auto ISO, 
so do your research.  
 
Basically, how you should think about it is that if your photo turns out too dark, 
simply use the “+” part of the button to make the next photo brighter. If it’s coming 
out too bright, turn it down to the “-” to make it darker. You can make gradual 
changes on a scale from -2 through to +2 (some cameras may offer wider ranges). 
 

It’s the job of your camera’s built-in 
light meter to measure the amount of 
light entering the lens.  
 
Then your camera takes over (if it’s in a semi/fully-
auto mode) and changes the aperture and/or 
shutter speed to make a balanced exposure; or as 
close to one as possible. 
 
The problem though comes from where the light 
meter is taking the reading from the whole frame, 
the middle or just a small spot.  
 
This may not result in the kind of shot you were 
looking to take - so how can you take further 
control?  
 

To darken 
highlights 
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Exposure 

Bracketing 

When letting your camera bracket the exposure you will be faced with a choice of how wide 
you wish to set the bracket. AEB (auto exposure bracketing) means the camera will decide on 
the range based on the scene. Otherwise, you may be able to select 0.5, 1 or 2 values to the left 
and right of your current f/stop.  
 
i.e. a 1 stop bracket starting at F/11 will mean 3 shots are taken (one at F/8, F/11 and F/16) and 
then all 3 shots will be compiled together, and you’ll see the resulting merge.  
 
Some cameras will still retain all 3 images (plus the composite) as separate files on your 
memory card. This means you can also do the bracketing in editing too. 

Bracketing your photos involves 
taking multiple images of the same 
scene at different settings to capture 
more detail. 
 
Depending upon your camera, you may have a 
built-in option do let your camera do the 
bracketing or you can do it manually.  
 
It may also be called HDR (high dynamic range). 
 

A wider bracketing range doesn’t necessarily mean a better photo. It may increase 
highlights too much and brighten your image too much, so it’s best to keep the range narrow 
to begin with and adjust based on results. 
 
If your camera doesn’t have a built-in bracketing function, then follow the same principle to do 
it manually. Shoot 3 images (or more if you wish) at different aperture settings. Take your shots 
and run them through software such as Photoshop or Lightroom to create an HDR composite.  
 

To read more about this section click here to access 250+ free photography articles to 

help you take amazing images and become a fantastic photo editor. 

 

F/5.6 F/11 F/8 
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Shutter 

Speed 

Choose the right mode and 
the correct speed for your 
subject or effect. 

 

 

Remember… 

Use longer/slower shutter speeds 
when the natural light is low. 

Use shorter/faster shutter speeds 
when the natural light is bright. 

For beginners, concentrate on learning your shutter speed by using S/Tv Mode (Shutter 
Priority). You can control the shutter speed and the camera will take care of everything else. 

To read more about this section 
click here to access 250+ free 
photography articles to help you 
take amazing images and 
become a fantastic photo editor. 

 

Fireworks 
Long light trails 

Night-time 
Blur moving water 
 

Light tracing 
Short light trails 

Dark buildings 
Panning effect 

Candlelight 
Low light with flash 
 

Golden hour 
Slowest speed for 
handheld 
 
 

Everyday 
People walking 

Sunny day 
Slow moving cars 

Sports action 
Animals / 
Wildlife 
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Sensor 

Sizes 

Full Frame Sensors 
 
Full frame sensors are reserved for the 
higher end market of digital cameras, 
but those prices are slowly starting to 
come down.  
 
A full frame sensor is one that is the 
same size as a single frame of 35mm 
film (36mm x 24mm). 
 
They are the largest types of sensors in 
comparison to others and with that 
requires a larger housing. 
 
This is why full frame cameras are 
typically found in DSLR’s or larger 
mirrorless cameras - never in compacts 
or smartphones. 
 

 

The sensor is the digital 
heart of your camera 
 
The size of this ‘digital heart’ 
determines how much light 
can be recorded; large 
sensors receive more light, 
and smaller sensors get less.  
 
The more light the sensor can 
detect, the better the image 
quality. 
 
There are variations of 
sensor size in different types 
of cameras. 
 

Cropped Sensors 
 

If you don’t have a full frame sensor, then you’ll 
otherwise have a cropped sensor. This is a smaller sensor 

in comparison but can fit inside smaller units giving 
purpose to mirrorless, bridge, compact and smartphone 

cameras. There are a range of sizes in the cropped 
sensor market. 

 
 

• APS-H (mirrorless/DSLR) 
• APS-C (mirrorless/DSLR) 
•  4/3 (bridge/mirrorless) 
• 1 in (bridge) 
• 1/1.63 in (compact) 
• 1/2.33 in (compacts) 
• 1/3.2 in (camera phones) 
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Sensor 

Sizes 

EXAMPLE 
 
If you are using a 100mm lens on a full frame camera then you are seeing the 
true focal length of 100mm. But if you switched that lens on to a cropped sensor 
camera (not all lenses are cross compatible in this way) with a crop factor of 1.5x 
then the focal length you’ll actually be seeing is 150mm.  
 
This completely changes your angle of view - it’ll be narrower with a 
compressed background behind a subject than it would look on a full frame 
camera. 
 

        

Crop Factor 
 
Because all these sensors are smaller than the full frame the images captured using them are determined 
based on a crop factor.  
 
The crop factor is used to calculate what the effective focal length of a lens would be in 35mm terms based 
on the focal length printed on the lens. Crop factors can range from 1.5x through to 2x or more.  
 
For example, if you put an 18-55mm lens on a camera with a 1.6x crop factor, you get the equivalent of a 28-
88mm lens in 35mm terms. It’s important to know your camera’s crop factor to understand what actual focal 
length your lens is operating at. 
 

What’s More Important:  
Sensor Size or Megapixel Count? 
 
Given what we know already about the importance and benefits of 
sensor size then you’ll understand why a 16MP compact camera (with a 
cropped sensor) isn't ever going to be as good as a 12MP DSLR (with a 
full frame sensor). 
 
Sensors consist of millions of light-sensitive spots called photosites 
which record what is seen through the lens. Therefore, a bigger sensor 
can gain more information than a smaller one and produce better 
images. 
 
Here’s a different way to think about it: If you had a compact camera 
with a cropped sensor, its photosites would be tiny in comparison to a 
DSLR with the same number of megapixels but a much bigger sensor.  
 
The DSLR with the bigger photosites can capture more dynamic range, 
less noise and generally works better in low light situations.  
 

100mm (Full Frame) 100mm (1.5x cropped) 
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Maximum 
Print Size 

 

Megapixels Pixel Resolution Max Print Size (@200dpi) 

12 4290 x 2800 21.45" x 14.00" 

16 4920 x 3264 24.60" x 16.32" 

21 5616 x 3744 28.08” x 18.72” 

24 6016 x 4016 30.08” x 20.08” 

30 6480 x 4632 32.40” x 23.16” 

36 7360 x 4912 36.80" x 24.56" 

If you are printing to an inkjet printer, a full frame picture from your 4000x3000px camera file will print a 
20x15 picture. Since the resolution of inkjets requires just 200DPI, divide 4000 (the width of your image) by 
200 to get the 20-inch measurement and divide 3000 (the height) by 200 to arrive at 15 inches.  
 
Since inkjet printers don't print with specific sized dots, you can get away with using 150DPI on output (thus 
producing a 26x20 inch print from your camera), but we wouldn't recommend going below that. 
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Lens 

Accessories 

The benefit of step-up rings is that it allows new photographers to borrow filters from other photography friends. They are a series of rings which 
accept filters of different thread sizes to be fitted on to one lens.  
 
 

Step-Up Rings 

 

Example 
 
You could use a 77mm infrared filter on a lens 
with a native 58mm thread size.  
 

There is an element ‘hacking’ by using step-up 
rings. It’s a quick short-cut to using any filter on 
a lens, instead of the right filter for the right 
lens.  
 
Imagine being a shoe size 7 but wearing a 
size 10 - of course, your foot will fit but is it the 
best fit?  
 
The downside is that step-up rings can be 
susceptible to light leaks and vignette around 
the edges as the rings can infringe when the 
lens is shooting wide.  
 
With that said they are cost-effective and 
helpful for beginners to try out different filters 
before deciding what works best for their own 
photography. 
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Lens 

Accessories 

Macro Filters 

 

Learn more with an 
iPhotography course Click here 

A much more budget-friendly approach to getting into macro photography is to purchase a set of macro filters, rather than 
splashing out on a dedicated macro lens.  
 
The filters can be purchased in a bundle of different magnifications from +1 through +10.  
 
They can help improve the appearance of small objects at close range, but you will still have to adhere to your lens’ minimum  focus distance. 
 
Try stacking a few filters on top to increase the magnification levels. Whilst they are a fun way to get closer to the miniature world they also come with 
drawbacks.  
 
The heavier the magnification the smaller the focus area becomes which will force you to keep your subject in the dead centre of the frame. This could 
cause your composition to look basic in some instances.  
 

https://www.iphotography.com/
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Lens 

Accessories 

Extension Tubes 

 

Without getting too technical, when your lens is set to its minimum focusing distance, the front 
element (the front of your lens) can’t zoom/move in any further. You have reached the limit of your 
focus range.  
 
To get closer shots you’ll need an extension tube. It’s a hollow tube that fits between your lens and 
camera body - not at the end of the lens. It moves the lens and sensor further apart, increasing the 
extension of the front element.  
 
This lets you move the lens closer to the subject, increasing magnification, and in some cases even 
matching the 1:1 magnification of a true macro lens.  
 

TIP: Extension tubes are a clever hack to get tighter in on 
macro scenes and best used on lenses between 30mm-
100mm.  
 
You can still use macro filters on the front of the lens too, but 
this extra amount of extension and magnification can start to 
reduce image quality so use them together sparingly. 
 

It’s worth being aware that if you are using a lens that electronically controls your aperture then 
cheaper extension tubes break that electrical connection between lens and body meaning you won’t 
have control over the exposure as much.  
 
Though you can purchase more expensive tubes that carry that electrical connection through the 
adaptor - it is worth looking out for these differences when purchasing. 
 
The best types of tubes are ones made by your own camera’s brand firstly. Otherwise, there are 3rd 
party ones available. 
 
Extension tubes are sold by extension size i.e. 16mm, 20mm etc. Keep an eye out as tubes are notorious 
for light loss and may require you to slow your shutter speed or bump up the ISO to compensate for the 
reduction of incoming light. 
 



Lens 

Accessories 

Conversion 
Lenses 

 

Conversion lenses give you an additional optic to thread onto the front of your existing lens to increase 
or reduce the effective magnification.  

With this you can either widen your field of view to look like a wide-angle (or fisheye) or narrow your 
perspective to give the look of a telephoto lens. 

Are They for You? 
 

Convertor lenses are perfect for 
photographers thinking of buying a 
new camera system but don’t want 
to leave their current lenses behind. 

 

Lens adaptors make it possible to mount a lens 
from one system onto the camera body of 
another system, such as mounting a Canon 
lens on to a Fuji camera.  
Ultimately, they are great money saver as 
buying a new camera isn’t cheap in the first 
place. 
 
Some conversion adapters are able to retain a 
full range of focus without the need for any 
additional optics. But others are fully manual, 
which means you have to judge the focus by 
eye instead. 
 

Reversing rings are a rarity in photography but still a creative tool. They allow you to mount a lens 
“backwards” onto your camera body. This offers an increased magnification without the need for a macro 
lens or filter.  
 
They are best used on lenses between 20mm-60mm. As well as it being a money saver they are also 
lightweight and compact too which is ideal for travelling photographers.  
 
Alongside the rings you may want to discover macro couplers. Similar to reversing rings, these male-to-
male couplers enable a photographer to reverse a lens to fit the front of a telephoto lens resulting in a 
quality macro photo. 
 

https://www.iphotography.com/


Pet 

Photography 

Choose a location that evokes a strong memory for 
you and your pet. For example, you might have a 
place that you take your dog all the time. It will mean 
a lot in the future as you look back over the portraits. 

 Tip 4   

If you are feeling creative, build a little scene or setting 
for your hamster, mouse, or rat. To overlook the cage 
bars, you can design an outdoor backdrop from card, 
so it looks like blue sky and flowery fields and place it 
inside the cage. Add some natural elements like sticks, 
leaves and foliage to create the impression of the wild. 

 

Nearly half of the world’s households 
have a pet of some sorts.  

If you’re one of those people who loves to 
snuggle up with your cat or go for walk with 
man’s best friend, then read these quick tricks 
for taking amazing portraits of your fluffiest 

family member. 

 

Shoot in Shutter Priority mode to give you 
scope to quickly change settings 
depending upon the pet’s reaction.  

If they are quite active, then stop any 
motion blur happening by using a fast 
shutter speed i.e. 1/400th. 

 Tip 2   

Action shots are not easy to capture at 
high speed, but you can use a focus mode 
that is available on all modern DSLRs 
called “Continuous/AF-C” (on a Nikon) or “AI 
Servo” (on a Canon).  

This mode is used for tracking moving 
subjects and it is a must for shooting 
wildlife.  

Continuous mode will automatically 
readjust the focus if you or your pet moves. 

 Tip 3   

One common mistake made by budding photographers is that they photograph their pet from a 
human height.  

This rarely works well. Photos of cats and dogs taken on their own level tend to have more impact and 
show the animal’s personality better, from the perspective of an equal. 

 Tip 5   

 Tip 1   



 Tip 4   

Bird 

Photography 

Don’t get too close to the bird 
with the camera as they may 
decide to attack it if they see it 
as a threat.  

Instead use a zoom lens to 
keep your distance. 

 

 Tip 2 

 

Choose Aperture Priority and not 
Shutter Priority, when 
photographing birds outdoors.  

If we are shooting at high shutter 
speeds, most likely the aperture will 
be always set to wide open which 
will always lose some detail in the 
final image, due the decreasing 
focus area.  

Worst of all, if the lighting 
conditions change quickly, the 
image might come out 
underexposed – and you might 
miss the opportunity.   

If you are shooting hand 
held, you will need to select 
a shutter speed that is 
equal to or a higher value 
than your lenses focal 
length, i.e. shooting at 
300mm then shutter 
speed needs to be 1/300th 

or faster, and 1/500th for 
lens around 500mm. This 
will help avoid motion blur 
in the image. 

 

 

There are so many passionate bird photographers out there trying their best capture pin 
sharp avian portraits.  

We’ve created a guide of the TOP TIPS that you’ll need to know so you don’t get in a flap! 

 Tip 1   

 Tip 3   

Invest in a fast Mirrorless 
or DSLR camera and 
one or more telephoto 
lenses.  

We would recommend a 
camera that can handle 
at least 1/2000th of a 
second shutter speed 
with 6 to 9 fps (frames 
per second). 

 

If the bird is watching 
your movements, stop, 
and wait for them to 
be distracted before 
you take another step. 

 Tip 5   
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 Tip 8   

Bird 

Photography 

The best time to 
photograph birds is either 
during the early morning or 
late afternoon. 

 Early morning is typically 
the best for bird 
photography, because birds 
are actively looking for food 
for themselves and their 
youngsters.  

 

 Tip 7 Aim to wear muted and dark 
clothes. Try and blend in to the 
environment – throw on a bit of 
camouflage if you’ve got it.  

Bright clothes are a NO!  

It will instantly make you stand out 
to a bird. 

 

 

Always focus on the nearest (to the 
camera) eye of the bird.  

It is acceptable to have a blurred tail or 
other parts of the bird, but at least one 
eye always needs to be sharp.  

For birds in flight, focus on the bird’s head 
or chest. 

 

 
 Tip 6   

 Tip 10   
Shoot lots of images, using burst or continuous mode to help you 
to freeze moments of take-off or shaking water off wings.  

These actions are fast moving, don’t miss the opportunity. 

 

If your camera has an AF 
(auto focus) beep assist 
(when the camera locks 
on focus it makes a little 
noise to signal to the user) 
then turn it off.  

The noise of the shutter 
will spook the bird so best 
to take a few shots at 
distance and more as you 
close in. Some mirrorless 
cameras feature a leaf 
shutter which is silent 
when firing – perfect! 

 

 Tip 9   
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Wildlife 

Photography 

One of the biggest challenges at the Zoo is to avoid the wire 
fences.  

If your camera has changeable focus zones, switch to using a  
small centre focus spot to stop it focusing on the fence and keep 
the animal sharp. 

 

 Tip 1 

If your camera has a manual or A/Av mode, adjust the 
aperture to its largest size (i.e. F/3.5). This will reduce 
depth-of-field and throw the fence out of focus.  

Hopefully the fence will be so blurred it will hardly be 
visible in the photograph. 

 

Don’t attempt to use a flash against glass this 
close as it scares the animals on the other side 
and most of the light will be reflected having no 
benefit on your exposure. 

  Tip 2 
Try creative motion panning shots by using a 
slow speed when shooting Lions and Tigers 
etc. Follow the path of the animal as you 
press the shutter.  

When panning aim for a shutter setting of 
around 1/8th to 1/30th, depending on the 
speed of the animal. 

 

 Tip 3 

Glass partitions can allow for surreal 
interaction between humans and animals.  

You can achieve images that make it look 
like people are touching the animals, by 
moving to an acute angle, and shoot parallel 
to the glass to see a profile of both subjects.  

You just need to be mindful of reflections of 
other visitors in the shot! 

  Tip 4 

To read more about this 
section click here to access 
250+ free photography 
articles to help you take 
amazing images and 
become a fantastic photo 
editor. 

 

If you are an animal lover and enjoy 
trips to the Zoo, then we’ve put 
together these 5 essential secrets 
used by pro photographers to 
capture incredible wildlife 
photographs. 

 

 Tip 5 
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Portrait 

Lighting 

Use this portrait lighting guide to 
capture dynamic and flattering 
photographs.  

Position your light source appropriately 
to create these techniques. 

Pose your subject so that their body is side on to 
the camera and turn their head to face the lens. 
Direct a single light towards the nearest (broad) 
side of their face, keeping the rest in shadow. 

Follow the same directions as in Broad lighting, 
but this time move your light to only light the far 
(narrow) side of their face. This will cast the 
near (broad) side of the face in shadow making 
your portrait look mysterious. 

Taken from the Dutch artist, Rembrandt 
lighting is signified by an inverted triangle 
underneath the subject's nearest eye. Follow 
the setup of narrow lighting but raise your 
light higher. 

Split lighting is incredibly 
easy. Start by facing your 
subject towards the camera 
and position a light source 90 
degrees to their body. It will 
'split' the face in half light 
and shadow.  

Perfect for  
telling a dark or sinister 
story. 

Following on from 
Rembrandt lighting, bring 
the light source closer to the 
camera position.  
Maintain the height of the 
light and shine more light 
on the cheeks.  

Aim to keep a gap 
between shadows beneath 
the nose and the and 
cheeks. 

 

Broad Narrow Rembrandt 

Loop Split 

Discover more on our incredible 
portrait photography course 

https://www.iphotography.com/portrait-photography-course/


Posing for 
Boudoir 

Leave a suggestion 

 

Bend those limbs   

 
All portrait poses should have 
angles to create conflict and 

leading lines. Bend your subject’s 
legs or arms to create triangles.  

These shapes stop your client 
looking flat, one dimensional and 

tense. 

 

Eye contact 

The eyes are the first place we 
look to on any portrait. They are 
the first line of the picture’s story.  

Direct your subject to convey the 
mood you’re creating with their 
eyes. Think of ‘intense’, 
‘suggestive’ or ‘innocent’ 
expressions to portray.  

If you want your shot to look less 
engaging, then ask them to look 
away from the camera. It then 
becomes more voyeuristic for 
the audience.  

 

Boudoir is all about beauty and/or temptation, if you 
give everything away then it leaves no further 
interest.  

Don’t ask your model to bare all, cover up private 
areas, leave a hint, or a suggestion. They should 
reserve their dignity whilst still showing their strength 
and power.  

Using sheer clothing is another way to tempt and 
tease.  

 

Making your client look alluring is essential when they bare all (almost). Use our boudoir photography 
posing checklist to create flattering and beautiful moments of sensuality. 

https://www.iphotography.com/portrait/
https://www.iphotography.com/portrait/
https://www.iphotography.com/portrait/
https://www.iphotography.com/portrait/
https://www.iphotography.com/portrait/
https://www.iphotography.com/portrait/
https://www.iphotography.com/portrait/
https://www.iphotography.com/portrait/


Posing for 
Boudoir 

Position the hands 

 

‘Windswept look’ 

Don’t forget to pay attention to the hair. 
Use a reflector or a fan to waft your 

model’s bonnet so it looks mid motion 
and dramatic.  

Combined with a low angle can make 
your subject look like a sexy 

superhero. 

 

 

Pay lip service 

The mouth has an 
incredible power of 
suggestion to an audience.  

Open mouthed shots look 
conversational, parted (or 
pouted) lips could suggest 
a kiss or bated breath.  

Closed mouths can look 
closed off or cold so make 
sure you strike the right 
mood. 

Don’t leave your subject lingering. Idle 
hands can look distracting and 
unprofessional. 

 Instead position them over your subject’s 
body, behind the head or clasped together 
to make them look purposeful.  
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Landscape 

Photography 

Tip 1 
Create a sense of depth by 
keeping everything in 
focus.  

Use a small aperture i.e. 
F/16-F/22 to keep the 
foreground and 
background sharp.  

Place your camera on a 
tripod when using a small 
aperture, as less light will 
be entering the lens. 

 

Tip 2 

Try using filters to balance your 
exposure. Polarising filters darken 
skies and brings out blues to 
contrast white clouds. Neutral 
Density (ND) filters prevent too 
much light from entering the 
camera. 

This is useful on bright days, when 
you want to try out long exposures 
without your shot coming out 
overexposed.  

Check your lens thread to get 
the right filter size. 

Use the rule of thirds to compose your landscape. Imagine four lines, two horizontal and two vertical 
crossing your shot to create nine even squares.  

Try placing your main subject off centre on one of the four intersecting points. This will often create a  
more aesthetically composed photograph. 

 

Tip 3 

 

If you love a good walk out 
into the countryside and 
want to make amazing 
memories of those 
wonderful vistas, then you’re 
in the right place.  

Check out our 5 
fantastic ideas to help 
you master landscape 
photography!  
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Landscape 

Photography 

Tip 4 

One element that can 
set apart your 
landscape shots is to 
think carefully about the 
foreground of your shots 
and by placing points of 
interest in them.  

Think about rocks, 
stones and cliff edges.  

When you do this, it 
draws in your audience 
to the image and makes 
helps them become 
more engaged to the 
shot. 

 

Always think about 
your horizon with 2 
questions in mind. ‘Is 
it level?’ and ‘where 
is it compositionally?’  

The best place for 
your horizon is on one 
of the horizontal 
third’s lines (either 
upper or lower) rather 
than completely in 
the middle. 

 

Tip 5 

Want to Master 
Landscape Photography?  

Visit iPhotography and join our 
incredible and comprehensive online 

training course. 

Our dedicated online landscape 
photography course for beginners 

will show you how to capture 
amazing photos of rivers, lakes, 

valleys, mountains and woodlands. 
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Car 

Photography 

 

You don’t have to understand the mechanics to appreciate the beauty of some 
cars.  

Therefore, we’ve designed a guide to help you capture the sleek aesthetics of auto photography. 

Sports cars especially are known for their 
power and imposing noise on the streets.  

To emphasise that stature get down low and 
shoot on a wide-angle lens to make your 
motor look grand and overwhelming. 

Get Low 

Certain cars are designed for 
particular environments. Think 
of an off roader, taking a 
picture of a 4x4 would see odd 
in a city.  

Create greater context for 
your motor by using the 
appropriate background.  

Take your off roader to a 
natural surrounding, sports 
cars to the racetrack and 
vintage rollers to retro 
locations. 

 

Give Context 

A sneaky insider secret from pro 
photographers! When parking your vehicle 
turn the front wheels in the opposite 
direction of your camera.  

It’ll make the car look dynamic, mid 
movement and as if it’s swerving to avoid 
you!  

 

Turn the Wheel 
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Car 

Photography 

 

Curvy Profiles 

Go Dark 

To add a little bit of mystery to your 
machine shoot at night and provide 
your own lighting.  

Little units such as LumeCubes are 
great portable lights to expose small 
areas, drawing attention in a low-key 
format.  

Park under streetlights or near neon 
signs for different effects. 

 

 

Just because a car is one unit 
doesn’t mean you only take one 
photo.  

Instead think of all the different 
unique features and elements they 
have.  

Capture iconic badges, wheels, 
spoilers, exhausts, grills etc.  

Don’t forget to shoot the inside 
too!  

This is a great way to create a 
texture filled collage, making a 
more colourful story. 

 

Think in Parts Some cars have sumptuous aerodynamic curves 
across their bodies.  

Shooting side-on (profile) to these motors will 
help show off those sleek rolling lines from front 
to back.  

Keep at a low angle and use a focal length 
below 30mm to help with the width. 

 

https://www.iphotography.com/


Want More? 

Join Today 

 

Join one our incredible and in-depth iPhotography courses. 
Designed by professional photographers for beginners.  

 

Camera Basics 

Exposure Triangle 

Composition 

Portraiture 

Landscapes 

Wedding Photography 

Wildlife 

Creative Light 

Photoshop  

Lightroom 

Luminar 

Affinity Photo 

Book of  

Photography 
Tips 
 Photo Feedback Gallery 

Photography Assignments 

Weekly Photo Challenges 

Download Asset Library 

100+ Extra Tutorial Videos 

PLUS Membership Available 

Critiques, Webinars & Talks 

https://www.iphotography.com/
https://www.facebook.com/Official.iPhotographyCourse/
https://www.iphotography.com/
https://www.iphotography.com/online-photography-course/
https://www.iphotography.com/online-photography-course/
https://www.iphotography.com/online-photography-course/
https://www.iphotography.com/portrait-photography-course/
https://www.iphotography.com/landscape-photography-course/
https://www.iphotography.com/wedding-photography-course/
https://www.iphotography.com/wildlife-photography-course/
https://www.iphotography.com/light-tricks-course/
https://www.iphotography.com/online-photoshop-course/
https://www.iphotography.com/lightroom-course/
https://www.iphotography.com/luminar-course/
https://www.iphotography.com/affinity-photo-course/
https://www.iphotography.com/
https://www.iphotography.com/
https://www.iphotography.com/
https://www.iphotography.com/
https://www.iphotography.com/
https://www.iphotography.com/
https://www.iphotography.com/
https://www.iphotography.com/
https://www.iphotography.com/
https://www.iphotography.com/

